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Cyclone Ita.  The Global Precipitation Measurement (GPM) Dual-frequency Precipitation Radar 
(DPR) observed Cyclone Ita on April 9, 2014.  The data in the image are near surface rain-rate 
estimates from the 2ADPR data product.  The Orbit Viewer THOR created this image.
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PUBLICATION HISTORY 

 
PPS, NASA Goddard Space Flight Center (GSFC), Greenbelt, Maryland. 
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Revised in 2017. 
 
To obtain a copy of the Orbit Viewer or this user guide, visit the PPS Web site 
[https://pps.gsfc.nasa.gov]. 
 
The Orbit Viewer for GPM and TRMM data was developed by the National Aeronautics and 
Space Administration (NASA), and any use of it should be acknowledged.  The GPM and 
TRMM data used in this user guide were provided by NASA and the Japan Aerospace 
Exploration Agency (JAXA).  The Orbit Viewer is written in the Interactive Data Language 
(IDL), which is manufactured by Harris Geospatial [https://www.harrisgeospatial.com/IDL].  If 
you have questions about the Orbit Viewer, please contact the Helpdesk at the Precipitation 
Processing System (PPS) at [helpdesk@mail.pps.eosdis.nasa.gov] or 301.614.5060.  
Alternatively, contact the Orbit Viewer developer at Owen.A.Kelley@nasa.gov or 301.614.5245. 
 



https://pps.gsfc.nasa.gov 

 4 

 
TABLE OF CONTENTS 

 

1.  INTRODUCTION .......................................................................................................5 

1.1  OVERVIEW ..........................................................................................................5 
1.2  DATA ....................................................................................................................6 
1.3  BUG REPORTS.....................................................................................................8 

2.  INSTALLATION ......................................................................................................10 

2.1  LINUX .................................................................................................................10 
2.1.1  libXp.so.6 Under 64-bit Linux ......................................................................12 
2.1.2  X Emulators and Dotted Lines ......................................................................12 

2.2  MAC OS X ..........................................................................................................12 
2.2.1  Mac OS X refuses to run the setup script .....................................................14 
2.2.2  X Windows ...................................................................................................14 
2.2.3  The One-Button Mouse.................................................................................15 

2.3  MICROSOFT WINDOWS ..................................................................................15 

3.  DATA DISPLAY.......................................................................................................16 

3.1  STARTING THE SOFTWARE ..........................................................................16 
3.2  THE MAIN WINDOW........................................................................................17 
3.3  FILE TAB ............................................................................................................19 
3.4  ARRAY TAB.......................................................................................................19 
3.5  POINT TAB .........................................................................................................20 
3.6  MAP TAB ............................................................................................................21 
3.7  PLOT TAB...........................................................................................................22 
3.8  TABLE TAB ........................................................................................................24 
3.9  TEXT TAB ..........................................................................................................25 
3.10  COLORS ............................................................................................................25 
3.11 3D VIEW ............................................................................................................27 

4.  FILE TYPES ..............................................................................................................30 

4.1  OBSERVATION GEOMETRY ..........................................................................30 
4.2  PHYSICAL FORMAT ........................................................................................31 

5. REFERENCES ...........................................................................................................32 

6.  GLOSSARY ..............................................................................................................33 

 



https://pps.gsfc.nasa.gov 

 5 

1.  INTRODUCTION 

1.1  OV E R V I E W  

Orbit Viewer THOR is a tool for displaying the standard data products of the GPM mission and 
TRMM satellite.  GPM and TRMM stand for Global Precipitation Measurement and Tropical 
Rainfall Measuring Mission, respectively, and the science team's website provides information 
about both satellites (https://pmm.nasa.gov).  The THOR tool comes in the form of a desktop 
application that a researcher can install on his or her computer.  THOR also comes in the form a 
JavaScript library that runs in a web browser, an online application that is integrated with the 
STORM data ordering system (https://storm.pps.eosdis.nasa.gov/).  The desktop-application 
version of THOR is the subject of this document. 
 
THOR enables a researcher to display any scientific array or any metadata field that is stored 
inside of a GPM or TRMM data file.  THOR's default display of each variable is intended to 
provide easy comparison between different storms in the same data file or between features 
within different data files.  The researcher is able to adjust the color table or other aspects of the 
display in order to make comparisons easier.   For variables that can be displayed on a map, you 
can zoom until the map displays a single data point.  For variables that cannot be displayed on a 
map, THOR provides a graphical or text-based display.  THOR's dynamically created images are 
for on-screen display.  This resolution may be sufficient for informal presentations (i.e., 
PowerPoint slides), but it is not intended to be publication quality. 
 
From November of 1997 to 2015, the Tropical Rainfall Measuring Mission (TRMM) satellite 
observed precipitation within approximately 35° of the Equator.  Starting in March of 2014, the 
Global Precipitation Measurement (GPM) satellite has observed precipitation within 
approximately 65° of the Equator.  Both satellites are joint missions between the United States 
and Japan.  In the United States, NASA's Precipitation Measurement Missions (PMM) science 
team contributes to analyzing the observations and to improving the data-processing algorithms 
[https://pmm.nasa.gov]. The TRMM satellite carries the first satellite-borne radar capable of 
measuring the detailed three-dimensional structure of precipitation, while the GPM satellite 
carries the first dual-frequency precipitation radar in Earth orbit. 
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The Orbit Viewer THOR is a tool for displaying GPM and TRMM standard products that are 
produced at the Precipitation Processing System (PPS) at NASA's Goddard Space Flight Center.  
"THOR" stands for "Tool for High-Resolution Observation Review" [Kelley 2013].  Since 1997, 
PPS has developed and distributed THOR.  THOR is primarily written in the Interactive Data 
Language (IDL).  The current version of THOR runs under Linux, Microsoft Windows, and Mac 
OS X.  THOR can be downloaded at no cost from the PPS Web site [https://pps.gsfc.nasa.gov]. 
 
In the fall of 1997, a few month prior to the launch of the TRMM satellite, PPS Project Manager 
Erich Stocker came up with the idea for a data viewer for PPS analysts and TRMM science-team 
members.  Research Scientist Owen Kelley developed the prototype, which was rapidly put into 
service and was soon distributed on the PPS website for any researcher to download at no cost.  
In 2009, Kelley completely rewrote the IDL code, preserving a core set of functionality and 
making it easier to add support for new data formats or functionality.  The new release of THOR 
was designated THOR 2.0.  In 2012, PPS began running an online version of THOR that was 
integrated into the STORM data ordering system.  Kelley developed THORonline in HTML, 
JavaScript, CSS, and CGI [Kelley 2013].  In 2015, THOR 2.2 was released when the version of 
IDL underlying THOR was upgraded to IDL version 8.3. 
 
Chapter 2 discusses installing THOR.  Chapter 3 describes how to display data with THOR.  
Chapter 4 provides information about specific types of files displayed by THOR. 

1.2  DAT A  

The GPM satellite carries two instruments for observing precipitation: the Dual-frequency 
Precipitation Radar (DPR), and the GPM Microwave Imager (GMI) [Hou et al. 2014].  The file 
format documentation and download instructions are available on the PPS website 
[https://pps.gsfc.nasa.gov].  The Japanese Aerospace Exploration Agency (JAXA) provides a 
more detailed file specification for the DPR data products [https://www.jaxa.jp].  GPM standard 
products are stored in the HDF5 format. 
 
Here is a table showing the most recent reprocessing of three categories of GPM data products: 
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 GPM Products  

 
GPM Core-

satellite 
GPM 

Constellation 
IMERG 

multi-satellite 
TRMM 
Products 

TRMM V7 -- -- -- 2011 

GPM Version 3 
(at-launch 
algorithm) 

fall 2014 fall 2014 spring 2015 
-- 

GPM Version 4 March 2016 fall 2016 March 2017 -- 

GPM Version 5 TBD TBD TBD TBD 

 
As of 2015, PPS has produced Version 7 standard products for the three instruments on the 
TRMM satellite for 1998 through 2015: the Precipitation Radar (PR), the TRMM Microwave 
Imager (TMI), and the Visible and Infrared Scanner (VIRS) [Kummerow et al. 1998].  Contact 
the following organizations for information about two other TRMM instruments.  For the 
Lightning Imaging Sensor (LIS), contact Marshall Space Flight Center 
[https://lightning.nsstc.nasa.gov], and for the Clouds and the Earth's Radiant Energy System 
(CERES), contact Langley Space Flight Center [https://ceres.larc.nasa.gov].  The 1998 to 2015 
date ranges contains two periods during which TRMM data products may be affected by changes 
in the satellite's orbital altitude.  In the first of these two periods (August 6 to 16, 2001), the 
TRMM satellite increased its orbiting altitude from 350 km to 402.5 km, an orbit change that 
conserved fuel and that thereby increased the duration of the TRMM mission.  In the second of 
these two periods (July 1 to August 5, 2004), NASA forbade the TRMM satellite from 
maintaining its orbit with orbits boost, which caused the TRMM satellite to drop in altitude.  The 
TRMM satellite's 402.5-km-altitude orbit was restored in early August 2004. 
 
For researchers who know what files they want or who want realtime data, PPS provides access 
via the File Transfer Protocol (FTP): 

 
ftp://arthurhou.pps.eosdis.nasa.gov/  GPM and TRMM standard products 
ftp://jsimpson.pps.eosdis.nasa.gov/data/ GPM realtime products 
ftp://trmmopen.gsfc.nasa.gov/    TRMM realtime products 

 
For the top two of these FTP sites, users must first register their email address with PPS before 
downloading files.  The URL for registering your email with PPS is 
https://registration.pps.eosdis.nasa.gov/ .  Users may also download TRMM and GPM standard 
products from the Goddard DAAC, now known as the Goddard Earth Sciences Data and 
Information Services Center (GES DISC) [https://disc.gsfc.nasa.gov/]. 
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TRMM standard products are stored in the HDF4 format, version 4.0r2.  This version of HDF4 is 
no longer available online, but it can still be obtained from PPS.  An HDF4 manual can be 
downloaded from [https://www.hdfgroup.org/].  Be aware that the HDF5 format and HDF-EOS 
format are not compatible with the HDF4 format of TRMM data products.  You must install the 
HDF4 library before you will be able to read HDF4 data into a C or FORTRAN program.  
Optionally, you may also install the PPS Input/Output Toolkit if you are using a UNIX 
computer.  If you do not need to read TRMM data into a C or FORTRAN program and you only 
want to make images, it is easier to install just THOR on your computer.  THOR works without 
you having to install the HDF library or the PPS Input/Output Toolkit. 
 
THOR is able to read and display HDF4 and HDF5 on its own because it is written in the IDL 
language.  IDL is manufactured by Harris Geospatial [https://www.harrisgeospatial.com/IDL].  
You do not need to install the IDL language on your computer before running THOR because a 
stripped-down copy of IDL comes packaged within THOR. 
 
Several terms are used in this user guide in very specific ways: algorithm, product, product 
version, product level, and swath.  An algorithm is a computer program that processes data.  PPS 
obtains its algorithms from the Joint Precipitation Science Team.  A product is a kind of data file 
that is defined by a particular set of variables, by the algorithm that calculates these variables, 
and by a physical format (such as HDF5). 
 
The level of a GPM or TRMM product indicates the degree to which the data have been 
processed.  Some level 1 products contain instrument-independent physical variables such as 
radar reflectivity or brightness temperature in the original observation geometry of the 
instrument (i.e., the satellite's data swath).  Other level 1 products contain engineering variables, 
such as returned power, that are instrument dependent.  Level 2 products have been further 
processed so that they contain geophysical variables such as rainfall rate.  Generally, level 2 
products have the same "swath" observation geometry as the corresponding level 1 product.  In 
contrast, Level 3 "gridded" products contain time-averaged and space-averaged data, such as 
monthly average rainfall rate in a rectangular latitude/longitude grid. 

1.3  B UG  R E POR T S 

If you find a bug in Orbit Viewer THOR, please contact the PPS Helpdesk at 
[helpdesk@mail.pps.eosdis.nasa.gov] or 301.614.5060.  When asking the Helpdesk a question or 
reporting an error, please include the following information: 
 

1.  What operating system are you using?  For example, is it Linux, Microsoft Windows, 
or Mac OS X?  Please be as specific as possible.  If you are running UNIX, please send 
us the output of the "uname -a" command.  If you are running Mac OS X, please send us 
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the version you are running.  You can determine the version by clicking on the Apple 
menu in the upper left of the screen and selecting "About this Mac." 

2.  What version of the Orbit Viewer are you using?  The version number is printed in 
zoom window when the Orbit Viewer session begins. 

3.  Please mention any error messages that appeared on the screen.  If you are running 
under UNIX, please start the Orbit Viewer with the "-e" option and try to recreate the 
error.  Then, send us any error messages that were printed to the UNIX console. 

4.  What operation were you performing when the error occurred?  For example, were 
you opening a file or creating a zoom image? 

5.  What is the name of the data file that you were displaying when the error occurred? 

6.  Have you purchased your own IDL license from Harris Geospatial, or are you using 
the embedded IDL license that comes with the freeware Orbit Viewer? 
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2.  INSTALLATION 

 

The Orbit Viewer THOR can be installed on many computers that run Linux, Mac OS X, or 
Microsoft Windows.  THOR is primarily designed to run under Linux.  The Orbit Viewer THOR 
normally runs in "freeware mode," which comes pre-licensed.  On Linux systems, THOR can be 
run alternatively in developer mode, which requires that you purchase an IDL license from 
Harris Geospatial.  Experienced software developers may wish to run THOR in developer mode 
because developer mode allows modification of the THOR source code. 

2.1  L I NUX  

Follow these steps to install the Orbit Viewer THOR on a Linux system. 
 
Download THOR from [https://pps.gsfc.nasa.gov].  Download the zip file that contains the string 
"linux."  This zip file contains 64-bit Linux software.  Place the zip file in your "~" home 
directory.  Never install THOR in a path where one of the directory names contains a space 
character. 
 
Uncompress THOR.  At the UNIX command prompt, type "unzip -qq filename.zip" to create the 
orbit directory. 
 
Run the setup script.  Go into the orbit directory ("cd orbit") and type "./setupUNIX.sh" to run 
the THOR setup shell script.  The orbitUNIX.sh launch script should now exist in the orbit 
directory. 
 
To enable you to easily launch THOR from any directory, create an alias.  If your login shell is C 
or T shell, use "alias thor path/orbitUNIX.sh" where "path" is the absolute path to the 
orbitUNIX.sh launch script.  Place this command in your .cshrc Linux startup file.  Alternatively, 
if your login shell is bash or Bourne, use "alias thor=path/orbitUNIX.sh" to create the alias.  
Place this command in your .profile Linux startup file.  From now on, you should be able to 
launch THOR by typing "thor" on the Linux command line. 
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When launching THOR on a Linux system, the following command line arguments are available: 
 

thor     Launch Orbit Viewer THOR without opening any file 
thor [filename]   Open a file 
thor -e [filename]  Open a file in error mode 
thor -d [filename]  Open a file in developer mode 
thor -i     Interactive mode 
thor -h     Print usage instructions 

 
By default, THOR is launched in "freeware" mode, i.e., you do not need to purchase any license 
before running it.  Also by default, THOR launches in the background and operates silently.  If 
an error occurs, restart THOR using the "-e" command line argument, which will cause THOR to 
print informational messages, warnings, and errors to the UNIX console.  If you wish to modify 
THOR source code, then you will first need to purchase an interactive IDL license from 
ExelisVIS, the manufacturer of IDL.  Then, launch THOR in developer mode using the "-d" 
command line argument.  If you launch THOR under Linux with the "-i" option, then an 
interactive IDL session is started with several useful procedures pre-compiled that you can use to 
read HDF4 and HDF5 variables into the IDL session. 
 
The rest of this section provides tips on specific issues that may arise when you install THOR on 
a Linux system. 

2.1.1  ELF file is ABI invalid 
 
If THOR silently crashes when you type just "thor" on the linux command line, then try typing 
"thor -e" to print out error messages and warnings.  When you type "thor -e" if you see an error 
message that your "ELF file" is "OS ABI invalid", then read on.  The problem may be that you 
are running an out-of-date linux system that is too old to support the version of IDL that comes 
packaged within THOR.  Starting with THOR version 2.2 (released in January of 2015), THOR 
is built with IDL 8.3, and IDL 8.3 only runs under linux version 2.6.32 or higher.  Centos 5 linux 
is built with linux version 2.6.18, which is too old to run IDL 8.3, while Centos 6 is built with 
linux version 2.6.32, which is able to run IDL 8.3. 
 
Here is the URL for the tech support article on this topic on the IDL website:  
http://www.harrisgeospatial.com/Support/HelpArticles/TabId/185/ArtMID/800/ArticleID/13776/
Error-ELF-file-OS-ABI-invalid-when-using-IDL-83-in-a-Linux-kernel-older-than-2632.aspx 
 
One solution to this problem is available to anyone with a licensed copy of IDL already installed 
on their system.  Such people can type "thor -d" to launch THOR using the copy of IDL already 
on their system, instead of the copy of IDL 8.3 that comes with THOR.  If this solution is 
unavailable to you, then please contact the PPS Helpdesk [helpdesk@mail.pps.eosdis.nasa.gov], 
and we will attempt to assist you. [Release 2.2] 
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2.1.2  libXp.so.6 Under 64-bit Linux 
 
When starting THOR on a 64-bit Linux system, IDL may crash and print the following error 
message to UNIX standard out: 
 

error while loading shared libraries: libXp.so.6: cannot open 
shared object file: No such file or directory 

 
This error is known to occur on some Red Hat Linux and CentOS Linux systems.  
ExelisVISTech Tip #3923 discusses this error.  The problem is due to IDL needing a different 
version of the X11 library than the version that is installed by default on some 64-bit Linux 
systems.  The following commands, executed by the system's root user, may install the required 
version: 
 

yum install libXp.x86_64 
yum install libXp 

 
[Release 1.3.6] 

2.1.3  X Emulators and Dotted Lines 
 
If THOR is running on a UNIX system, but you are displaying the results on the monitor of a 
Microsoft Windows system, you may experience difficulties with dotted lines.  In some 
situations, all line styles other than solid will appear as dashed lines.  This means that dotted 
lines and dash-dotted lines will be displayed incorrectly as dashed lines.  The cause of the 
problem is your X windows emulator.  The emulator is the software that allows your UNIX 
session to open a display on your Microsoft Windows monitor. 
 
If you are using the MI/X X windows emulator, there is no known solution, but if you are using 
the Exceed X windows emulator, try the following steps: With the right mouse button, click on 
the Exceed bar at the bottom of the screen.  In the menu that pops up, select Tools and then 
Configuration.  In the exceed.cfg-Xconfig window that appears, double-click on Performance.  
In the Performance window, make sure that there is a checkmark in the box next to "Exact Zero-
Width Lines."  Click OK in the Performance window to dismiss it.  [Release 1.3] 

2.2  M AC  OS X  

Follow these steps to install the Orbit Viewer THOR on a Mac OS X desktop or laptop system. 
 
Download THOR from [https://pps.gsfc.nasa.gov].  Download the zip file that contains the string 
"mac."  Place the zip file in your "~" home directory.  Never install THOR in a path where one of 
the directory names contains a space character.   
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For decades, the user's home directory on the Mac's hard drive was the recommended location 
for personal files.  Since THOR sits on top of the operating system and in no way modifies the 
operating system, the home directory remains the preferred location for installing THOR.  
Breaking with tradition, recent releases of the Mac OS X operating system hide the user's home 
directory by default in the OS X graphical user interface (GUI).  To install files in the home 
directory, one can use the Mac OS X terminal utility (cd to /Users/[username]/home/ or 
~[username]) or one can modify a single setting in the Mac OS X Finder GUI (the cubist 
blue/white face icon ) to make the home directory (the house icon ) visible in the Finder.  To 
make your home directory visible in the Finder, start the finder.  In the Finder menu, select 
Preferences.  In the Preferences pop-up window, select the Sidebar tab.  In the Sidebar tab, check 
the checkbox next to the row that has the house icon followed by your username.  Click the red 
button at the upper left of the Preference window to close the Preference window. 
 
Uncompress THOR.  To uncompress the file using software that comes with Mac OS X (i.e., 
Stuffit Expander), use the Finder to double-click on the zip file that you just downloaded.  This 
operation should create an orbit directory.  You can also perform this task in the Mac OS X 
terminal utility by typing "unzip THOR*.zip".  The terminal utility ( is usually stored in the 
Utilities folder within the Finder's Applications folder. 
 
Run the setup script.  In the Mac OS X Finder, double-click to enter the orbit directory.  Double-
click on the setupMAC.command script.  Verify that setupMAC.command created a Unix shell 
script called orbitUNIX.sh and a Mac application called orbitMAC.app.  You can also perform 
this task by typing "./setupMAC.command" in the Mac OS X terminal utility, once you are in the 
directory that contains this AppleScript file. 
 
Optionally, create a desktop shortcut.  To create a shortcut, hold down the control key (ctrl) and 
click on the orbitMAC file.  From the menu that pops up, select Make Alias.  Drag the 
"orbitMAC alias" file that is created onto your desktop. 
 
From now on, you should be able to launch THOR by double-clicking the orbitMAC file or any 
shortcut to that file.  In addition, you can open a PPS data file by dragging and dropping that file 
onto the orbitMAC file. 
 
The rest of this section provides tips on specific issues that may come up when you install THOR 
on a Mac. 
 

2.2.1  Mac OS X XQuartz X-windows library refuses to launch THOR 
 
In the fall of 2016, the XQuartz X-windows library (starting with XQuartz 2.7.10) is 
incompatible with the IDL startup script originally used by THOR.  This issue can affect THOR 
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only when it is run under Mac OS X.  The THOR distribution has been updated to correct this 
issue.  Anyone still running an older version of THOR that stops working following a Mac OS X 
system update may wish to consider downloaded an updated version of THOR from the PPS 
website.  Alternatively, the user may edit the idl/bin/idl text script stored within THOR's "orbit" 
directory.  Immediately below this line of code... 
 

export DYLD_LIBRARY_PATH 

 
...insert the following line of code: 
 

export DYLD_LIBRARY_PATH=/opt/X11/lib/flat_namespace:$DYLD_LIBRARY_PATH  

 
This solution is based on an IDL tech support article found on the Harris Geospatial website that 
was posted 24 October 2016 and titled: "XQuartz 2.7.10 is not compatible with ENVI 5.3.1 and 
IDL 8.5.1", available online at 
http://www.harrisgeospatial.com/Support/HelpArticlesDetail/TabId/219/ArtMID/900/ArticleID/
14944/XQuartz-2710-is-Not-Compatible-with-ENVI-531-and-IDL-851.aspx . 

2.2.2  Mac OS X refuses to run the setup script 
 
Under OS X 10.9 "Mavericks" and later versions of OS X, your system might refuse to run the 
THOR setup script orbit/setupMAC.command when you double click on it in the Finder 
window.  The reason for this action is that the default security settings allow you to run 
applications downloaded only from the apple store or certain other developers.  To override this 
block for specifically the THOR setup script, follow one of these two procedures: 
 
Solution #1: In the Mac OS X Finder, command-click on the orbitMAC.app file.  Command-
click means that you hold down the key on the keyboard that is labeled "command" and has the 
four-sided cloverleaf that used to be called the "Apple key".  While you are holding down this 
key, you click on the file that you want to examine.  In the pop-up menu that appears, select 
"Open".  This procedure has been tested on Mac OS X 10.12 Sierra. 
 
Solution #2: An alternative solution: In the upper left corner of your screen, click on the apple 
menu and select System Preferences from the pulldown menu.  In System Preferences window, 
select Security&Privacy.  In the General tab, you'll see the three possible settings for "Allow 
apps downloaded from."  Just below those settings there may be a statement 
"setupMAC.command was blocked" with an Open Anyway button to the right of this statement.  
Click the Open Anyway button, which should unlock the THOR setup script.  This procedure has 
been tested on Mac OS X 10.10 Yosemite.  [Release 2.1] 

2.2.3  X Windows 
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In late 2013, Apple released Mac OS X 10.9 "Mavericks", which removes the default version of 
X11 that was available on most OS X systems prior to OX 10.9.  Orbit Viewer THOR requires 
X11 to run.  When you try running Orbit Viewer THOR on such a system, you may get the error 
"You need X11? Would you like to install it?"  You can click "Yes" to install the XQuartz 
version of X11. [Release 2.1] 
 
In 2014, Apple released Mac OS X 10.10 "Yosemite", in which you use a somewhat different 
mechanism to obtain X11.  Under OS X 10.10, open the Finder and go to Applications.  Open 
Utilities.  Double click on the X11 icon.  A window will appear that asks if you want to install 
X11.  Click "Yes" and follow the directions that appear on the screen. [Release 2.2] 

2.2.4  The One-Button Mouse 
 
If you are using a Mac one-button mouse and you want to do a right click, hold down the control 
(ctrl) key before clicking the mouse.  [Release 1.3.5] 
 

2.3  M I C R OSOF T  W I NDOW S 

Follow these steps to install the Orbit Viewer THOR on a Microsoft Windows system. 
 
Download THOR from [https://pps.gsfc.nasa.gov].  Place the winXP zip file in the root directory 
of your hard drive, which is usually "C:\."  Never install THOR in a path where one of the 
directory names contains a space character. 
 
Uncompress THOR.  Double-click on the My Computer icon on your desktop, and open the C:\ 
folder.  To uncompress the file using software that comes with Windows, right-click on the zip 
file that you just downloaded and select Extract All from the menu that pops up.  This operation 
should create a C:\orbit directory. 
 
Run the setup script.  Double-click to enter the orbit directory.  Double-click on the 
setupWIN.bat setup script.  Verify that the setup script created a batch script called 
orbitWIN.bat.  To create a desktop shortcut, right-click on the orbitWIN.bat file, select Create 
Shortcut from the menu that pops up, and drag the shortcut file onto your desktop.  Be sure that 
your desktop directory path does not contain any space characters, or THOR will not launch 
from that shortcut. 
 
From now on, you should be able to launch THOR by double-clicking the orbitWIN.bat file or 
any shortcut to that file (pending the caveat above).  In addition, you can open a PPS data file by 
dragging and dropping the file onto the orbitWIN.bat file. 
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3.  DATA DISPLAY 

3.1  ST AR T I NG  T H E  SOF T W AR E  

Before examining data, you must launch Orbit Viewer THOR.  To launch THOR on a Linux 
system, run the orbitUNIX.sh shell script in the orbit directory or type "thor" at the Linux 
command line if you have setup an alias to orbitUNIX.sh.  To launch THOR on a Microsoft 
Windows or Mac system, double-click on the "C:\orbit\orbitWin.bat" file or "orbitMAC", 
respectively.  If you have not yet installed THOR, see the installation instructions in Chapter 2. 
 
A sample HDF file (a TRMM TMI 2A12.*.HDF subset file) is provided with THOR as the first 
item in the Data folder under the main Orbit folder.  To download other PPS data files, go to the 
following URL with your web browser: https://pps.gsfc.nasa.gov.  On that page, select Data from 
the left menu and choose TRMM Public Data Archive.   Select By Date, then V07, and last 
select data that is ordered by algorithm name.  On a Microsoft Windows system, be sure that you 
have installed Winzip or a similar program on your computer so that you can you can 
uncompress the *.gz files from the PPS archive before opening the files in THOR. 
 
To open a file, select the File Open menu item in the upper left of THOR's main window.  
Alternatively on a Linux system, you can include the filename on the command line when you 
launch THOR.  On a Windows or Mac system, you can open an HDF file by dragging and 
dropping the file onto the Orbit icon (C:\orbit\orbitWIN.bat or orbit/orbitMAC). 
 
Once a file is open, the left side of THOR's main window will show the list of the objects that the 
file contains.  To display an object, click on its name in the list.  To open a folder, click on the 
plus sign to the left of the folder's name or double-click on the folder's name. 
 
If the object that you selected can be displayed on a map of the Earth, then it will be displayed in 
the Map tab on the right side of THOR's main window (Figure 3.1).  If this array contains more 
than two dimensions, then click on the Array tab on the left side of THOR's main window to 
select which element of the additional dimension or dimensions to display.  You select an 
element by moving the appropriate slider widget with your mouse (the slider is visible with a 
variable with three or more dimensions).  Alternatively, to nudge the slider over in increments of 
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1 you can use the arrow keys.  By default, THOR displays the "zeroth" element of each 
additional dimension of an array. 
 
When examining numeric data, it is important to remember that THOR is a zero-based 
application.  For example, sliders go from zero up to one less than the number of elements in a 
dimension.  In addition, the axes of plots also go from zero to one less than the number of 
elements in a dimension. 

3.2  T H E  M AI N W I NDOW  

When learning to use THOR, it can be helpful to keep in mind the general layout of THOR's 
main window (Figure 3.1).  The left half of the window contains tabs for selecting data.  The 
right half of the window contains tabs for displaying data that you have selected, whether on a 
map of the Earth, as an image, or as text.  The following paragraphs describe these tabs and other 
parts of the THOR main window. 
 

 
Figure 3.1.  THOR's main window. 
 
Along the top of THOR's main window is a Menu bar (File, View, Option, and Help menus) that 
enables you to perform various functions or change display settings from their default value. 
 
The File menu permits you to do the following: 
 
• Open File:  Open a data file for viewing. 
• Open URL:  Open a URL where the data file is located. 
• Close File:  Close the data file you are viewing. 
• New Window:  Open a new THOR Orbit Viewer graphical user interface (GUI). 
• Save Image/Text:  Save a map image, plot image, table text, etc. 
• Save Data:  Save a data file in .png, .gif, .tif, or .txt format. 
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• Quit:  End the session and close the GUI. 
 
The View menu permits you to do the following: 
 
• Refresh:  Regenerates the image. 
• Goto: Open a window that lets you center the zoom window on a user-specified lat/lon 

location. 
• Object:  1) View Attributes:  Display any attributes that may be attached to the currently 

selected data object (same function as the "A" Attribute button described on the next page).  
2) View Properties:  A separate window pops up to display the file's properties.  3)  Assign 
Lat/Lon:  A separate window pops up and allows you to apply specified latitude and 
longitude to a variable.  4) CDF in File:  View the cumulative distribution function of the 
actual values in the file.  5) CDF Unscaled:  View the cumulative distribution function of an 
object's values after any available unscaling is applied to the object.  6) View as Text:  View 
the entire data array in a list format. 

• Swath:  1) 3D View: Display 3D radar reflectivity or rain estimates with an isosurface.  2) 
Global Find:  Locate specific values in a swath.  3) Plot with Circles:  When zoomed in on 
the map, view each field of view as a circle. 

 
The Option menu permits you to do the following: 
 
• Color Table:  Change the colors in the color table and the mapping of data to the color table 

(see Section 3.10). 
• Map Projection:  Choose the point to be placed at the center of the zoom image or change the 

map projection. 
• Shrink/Expand Window:  Change the dimensions of your view window. 
 
The Help menu permits you to do the following: 
 
• Debug:  1) Profiler:  Diagnose slow performance in the Orbit Viewer software.  Click once to 

activate, and a second time to view the report.  2) Console:  Open a limited command line to 
diagnose IDL settings and compiled procedures.  3)  Command Line:  Start at the IDL 
command line; you need to be in debug mode and using a licensed copy of IDL.  4) Color 
Test:  View all colors used by the Orbit Viewer to verify monitor settings.  5)  Cleanup Heap 
Variables:  When you open and close many HDF files in a single THOR session, it is 
possible in some circumstances for memory leaks to occur.  This menu option causes those 
memory leaks to be cleared.  Normally you should not need to use this option because simply 
ending the THOR session also clears all memory that has been used by THOR.  6)  Reload 
Static Colors:  Reload the color table configuration file that you have edited 
(data/static_color.txt file). 

• About Viewer:  Display information about the Orbit Viewer THOR. 
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• Note:  Next to the Help button along the menu bar is a set of numbers, i.e., 16M/19M.  These 
numbers represent the current memory usage and the session's maximum memory usage, 
respectively. 

3.3  F I L E  T AB  

The File tab is located on the left side of the THOR main window, and is shown in Figure 3.2.  If 
multiple files are currently open, the drop-down menu at the top of the File tab permits you to 
select among the open files.  Below the drop-down menu is a list of objects contained in the 
currently selected file.  Text objects, such as metadata fields, are preceded by a text icon.  When 
you click on a text object, it is displayed in the Text tab on the right side of the main window.  
Folders are preceded by an open or closed folder icon.  Data objects are preceded by a square 
icon.  When you click on a data object, it will be displayed, by default, in the Map or Plot tab 
depending on whether the data object can be geolocated on a map of the Earth. 
 

 
Figure 3.2.  The File tab. 

3.4  AR R A Y  T AB  

The Array tab is located on the left side of the THOR main window.  The Array tab enables you 
to select a two-dimensional slice of the variable that you have previously chosen in the File tab.  
If the selected variable only has one or two dimensions, it is unnecessary to use the Array tab. 
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If the selected variable contains three or more dimensions, one can change which two-
dimensional slice is displayed by moving the sliders in the Array tab.  For the 3D rainfall 
variable shown in the figure, the Array tab is set to show a horizontal cross-section on a map of 
the Earth because all fields of view (fov) and scans are currently displayed.  If you wish to 
display a vertical cross-section of the array, use the pull-down menu at the bottom of the Array 
tab to select one or two other variables to display.  For example, to display a cross-track vertical 
cross-section, select the "layer+fov" item from the pull-down menu. 
 

 
Figure 3.3.  The Array tab. 
 

3.5  POI NT  T AB  

The Point tab is located on the left side of the THOR main window.  The Point tab displays 
information about a single point of a data array that is displayed on a map of the Earth.  The 
information printed in the Point tab varies depending on the array being displayed, but generally 
the information includes the location of the point, its data value, and the time that the observation 
was made.  A point is selected by clicking on the Map tab on the right side of the main window, 
as described in Section 3.6.  The colored box at the bottom of the Point tab identifies the color 
with which the data point is displayed in the Map tab. 
 
The Option menu at the bottom of the Point tab enables you to do the following: 
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• Select Extra Variables: By default, the Point tab prints out the value of only the currently 
displayed variable and at the array index selected when the user clicked on the Zoom image.  
Use the Select Extra Variable menu item and pick additional variables if you want their 
values also printed at the selected array index. 

• Disable Selected Point:  By default, THOR will continue to display with a plus sign the 
location of the selected point even when you adjust the location of the Zoom image.  If you 
no longer want the select point highlighted, select the Disable Selected Point menu option. 

 

 
Figure 3.4.  The Point tab. 
 

3.6  M AP T AB  

Initially, the lower portion of the Map tab shows the entire spatial extent of the data (Figure 3.5).  
To zoom in, click on the lower portion of the Map tab.  In response, THOR will display a zoom 
image in the upper portion of the Map tab.  A companion Color bar will be displayed to the right 
of the zoom image.  Along the left side of the Color bar is a vertical line; this line indicates the 
range of data being displayed on the map or plot.  The small horizontal cross bar indicates the 
median data value being displayed.  To zoom in closer on the map, use the pull-down menu on 
the lower right corner of THOR's main window.  You can re-center the zoom window by 
dragging the cursor across the zoom window.  Obtain information about a single data point in the 
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zoom window by clicking on the zoom window.  The information about that data point will 
appear in the Point tab on the left side of THOR's main window. 
 

 
Figure 3.5.  A swath array displayed on a map of the Earth. 

3.7  PL OT  T AB  

There are situations in which it is helpful to display an array that is not on a map of the Earth.  In 
these situations, click on the Plot tab of THOR's main window. 
 
Figure 3.6 shows an image in the Plot tab on the right of the THOR main window and the Array 
tab displayed on the left side of the THOR main window.  By default, the entire two-dimensional 
array is shown in the image. 
 
To zoom in on an image displayed in the Plot tab, use the expansion buttons (   and  ) along the 
bottom of the Plot tab.  At the bottom of the Plot tab, there are also shift buttons (
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For arrays with more than two dimensions, use the sliders in the Array tab on the left side of the 
THOR window to select which element is to be displayed from the additional dimensions. 
 

 
Figure 3.6.  An image in the Plot tab. 
 
If you wish to switch to a one-dimensional line plot of the variable, select the dimension of 
interest from the pull-down menu near the bottom of the Array tab on the left side of the THOR 
main window (Figure 3.7). 
 

 
Figure 3.7.  A line plot in the Plot tab. 
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3.8  T AB L E  T AB  

The Table tab is located on the right side of the THOR main window, as shown in Figure 3.8.  
An object displayed graphically in the Map or Plot tab can have its numerical values examined in 
the Table tab on the right side of THOR's main window. 
 
Click on the Table tab when you want to see a text print-out of a portion of a data array.  Use the 
horizontal and vertical sliders to change which portion of the object is displayed in the table.  If 
you want to change which dimensions are displayed, use the pull-down menu at the bottom of 
the Array tab on the left side of the main window.  The Option menu at the bottom of the Table 
tab allows you to do the following: 
 
• Copy Location:  1) From Map:  Get the input data for the table from the Map tab.  2) From 

Plot:  Get the input data for the table from the Plot tab. 
• Turn On/Off Scaling:  Turn the scaling off to see the actual values in a file. 
• Change Cell Format:  Change the format of the numbers displayed in the table to floating 

point or integer. 
• Save Table:  Save a table to a directory on your computer. 
 

 
Figure 3.8.  The Table tab. 
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3.9  T E X T  T AB  

The Text tab is located on the right side of the THOR main window, and is shown in Figure 3.9. 
 
File metadata and other pure text objects are displayed in the Text tab.  If THOR displays a text 
object incorrectly as if it were numeric data, select the View Object View As Text menu item 
to display the object in the Text tab.  If you wish to see the metadata attributes of an individual 
object, select the View Object View Attributes menu item. 
 
The example in Figure 3.9 shows the Core Metadata object of a TRMM version 6 HDF file.  If 
you wish to search for a word within the text displayed in the Text tab, type the word in the text 
field at the bottom of the Text tab and click the Find button next to that text field.  The Option 
button allows you to Split Line and Save Text. 
 

 
Figure 3.9.  The Text tab. 
 

3.10  C OL OR S 

When possible, THOR uses a static color table for displaying an array, regardless of the range of 
data in that array.  A static color table makes it possible to easily compare the same array from 
two different time periods, such as a rainfall estimated from two different orbits of the TRMM 
satellite.  The static color tables are stored in an orbit/data/static_color.txt text file.  You can edit 
this text file to suit your preferences. 
 
When a static color table is available for a variable, then the variable is plotted using rainbow 
colors with the bottom and top colors set by the static color table.  The static color table also 
specifies whether the data is linearly mapped to the color table or whether it is logarithmically 
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mapped.  Logarithmic mapping is appropriate for variables such as rain that can take on a large 
range of values, but for which most observations are near the bottom of that range. 
 
When a static color table is unavailable, THOR plots the variable in muted colors.  The data 
value mapped to the top and bottom of the color table are chosen based on the values in the 
particular file that is currently open. 
 
You can alter the color table using the Option Color Table menu item.  When this menu item is 
selected, an Color Table window appears.  The Color Table window has three tabs, a Data tab, a 
Color tab, and a Size tab.  Figure 3.10 shows the Data tab of the Color Table window.  At the top 
of the Data tab, you can change the data values that are mapped to the top and bottom of the 
Color bar.  To the right of these fields, a pull-down menu permits you to change whether the data 
values are mapped logarithmically or linearly between the specified upper and lower bounds.  At 
the bottom of the Data tab is a list of the known "special values," defined one to a row.  For 
example, in many arrays a value of -9999 indicates missing observations.  At the left edge of 
each row, a box indicates if the special value is currently active.  By default, THOR looks for all 
currently active special values when displaying an array.  If any data points have one of these 
special values, then the color table on the right of the Map and Plot tabs will indicate the 
existence of that special value.  You can "turn off" any special value by unchecking the box on 
the left edge of that special value's row in the Data tab of the Color Table window.  Click the 
Apply button to apply any changes made to the color table.  The Dynamic button will apply the 
grayscale and dynamically adjust the min/max to maximize contrast.  The Reset button will reset 
all of the default values and the color scale. 
 

 
Figure 3.10.  Altering the data limits of the color table. 
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The Color tab of the Color Table window allows you to stretch the color table using sliders and 
to switch to an entirely different set of colors for displaying continuous data.  The Reset and 
Reverse buttons on the Color Table allow you to change your color set and then change it back 
again.  Figure 3.11 shows the Color tab. 
 
The Data tab in the Color Table allows you to select various flags that may be embedded in the 
data.  You can choose Linear or Log from the pull-down menu in the Data tab, and the Dynamics 
button displays your choices in the map on the right side of the screen. 
 
The Size tab in the Color Table displays point data symsize, circle symsize, and circle data 
minimum displayed. 
 

 
Figure 3.11.  Altering the colors in the color table. 
 

3.11 3D V I E W  

For certain 3D variables, you can view them in 3D by generating an isosurface, i.e. the 3D 
volume that contains all points in excess of a specified threshold.  The only variables that THOR 
can display in 3D are radar reflectivity and radar estimates of 3D rainfall rate.  These quantities 
are contained in the TRMM 2A25 algorithm and the GPM 2AKu, 2AKa, and 2ADRP 
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algorithms.  The following example uses the TRMM 2A25.correctZFactor variable which 
contains 3D radar reflectivity in units of 0.01 dBZ (dBZ scaled by 100). 
 
First, open a 2A25 file and select in the left-hand column the correctZFactor variable.  Click on 
the global region to select a zoom region.  Select the View Swath 3D View menu option.  
After a short delay to format the data, a window such as the following one will open to display 
the data. 
 

 
Figure 3.12.  3D Window 
 
To change the angle and position of the view-point, you can use the arrow buttons in the Quick 
Adjust box of the 3D window.  The buttons labeled "Rotate viewpoint" allow you to increase or 
decrease the azimuth angle and elevation angle of the viewpoint.  The buttons labeled "Slide 
canvas" moves the position of the canvas to the left, up, down, or right.  As one would expect, 
the Zoom In and Out buttons increase or decrease the zoom factor of the image.  By default, the 
3D image is in color, but a grayscale image can be generated if one changes the Display 
pulldown from Color To Gray.  Grayscale images can be generated much faster than color 
images, so the grayscale is useful when doing many adjustments to the view-point. 
 
The File menu of the 3D window allows you to save the 3D image in a PNG file that can be 
displayed by web browses and other common display tools. 
 
The Option menu allows you to change the types of image controls displayed.  Most users will 
only use the following two options in the Option menu: Quick adjust and Threshold.  The Quick 
adjust box was described above.  The Threshold box allows you to change the data value of the 



https://pps.gsfc.nasa.gov 

 29 

threshold that defines the outer isosurface displayed in the image.  By default, only the outer 
isosurface is displayed in the image.  If you wish to see the inner isosurface nested within the 
outer isosurface then increase the Inner Fraction text field from 0.0 to some value less than 1.0, 
such as to 0.5.  After typing a new value in the Inner Fraction text field, type the enter key. 
 
The 3D image-generation routines were written in IDL by the THOR developer using a 
technique described in a paper published in Elsevier's Computers & Geosciences journal [Kelley 
2013, pp. 228-237].  
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4.  FILE TYPES 

 

4.1  OB SE R V A T I ON G E OM E T R Y  

The two observation geometries for arrays are grids and swaths.  PPS level 1 and 2 files 
generally have swath geometry, while PPS level 3 files generally have grid geometry. 
 
A swath is collected by an instrument that is scanning across the direction of motion of the 
satellite.  Many TRMM swath arrays have two dimensions: field of view and scan number.  A 
field of view is an individual observation.  A scan line is one row of fields of view.  Some swath 
arrays have additional dimensions such as height or instrument channel. 
 
When interpreting swath data, it can be useful to remember that the TRMM satellite reverses 
direction every few weeks.  Sometimes the satellite is pointing forward, i.e., in the plus X 
direction (+X).  At other times, the satellite is pointing backward, i.e., in the minus X direction  
(-X).  Also, the various TRMM instruments—the Precipitation Radar (PR), TRMM Microwave 
Imager (TMI), and the Visible and Infrared Scanner (VIRS)—scan in different directions. 
 
When the TRMM satellite is moving in the +X direction, the TMI instrument scans ahead of the 
satellite, and the first field of view in the TMI swath is at the swath's northern edge.  Meanwhile 
the Precipitation Radar and VIRS instruments are scanning below the satellite, and the first fields 
of view in their swaths are at the swaths' southern edge.  Conversely, when the TRMM satellite 
is moving in the -X direction, then the first TMI field of view is at the southern edge and the first 
PR and VIRS fields of view are at the northern edge. 
 
TRMM grids are composed of boxes of data that each cover a particular number of degrees of 
latitude and longitude, such as 5 degrees.  The 3G family of data products contains gridded data 
stored in a special text format.  Rather than containing all grid boxes including empty boxes, the 
3G products contain only the grid boxes that happen to contain one or more observations during 
the observation period covered by the file. 
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4.2  PH Y SI C AL  F OR M AT  

From the 1997 launch through reprocessing cycle 7, most TRMM products are written in the 
HDF4 physical format.  The exception is the 3B4* family of real-time products, which are 
written in a binary format with an ASCII header.  The 3G6* family of products are written in the 
ASCII format.  In the GPM era, standard products will be produced in HDF5 format. 
 
Most GPM products are written in the HDF5 physical format. 
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6.  GLOSSARY 

 

1C21 – A standard TRMM algorithm that contains single-orbit uncorrected reflectivity data from 
the Precipitation Radar. 
 
2A12 – A standard TRMM algorithm that contains single-orbit rain estimates from the TRMM 
Microwave Imager. 
 
2A25 – A standard TRMM algorithm that contains single-orbit rain estimates from the 
Precipitation Radar. 
 
3G68 – A TRMM algorithm that contains hourly 0.5 degree gridded rain estimates for 1 full day 
from the 2A12, 2A25, and 2B31 algorithms. 
 
ASCII – American Standard Code for Information Interchange.  In this user guide, an ASCII file 
is used as a synonym for a pure text file.  If an ASCII file were read as a stream of one-byte 
integers, character meanings could be assigned to some of the 256 values of an unsigned one-
byte integer: a-z (97-122), A-Z (65-90), blank space (32), C end of string (0), tab (9), new line 
(10).  In a text file created on a UNIX system, lines end with a byte value of 10.  In a text file 
created on a Microsoft Windows system, text lines end in a two-character sequence of [10,13]. 
 
byte – An eight-digit number in base-two.  An unsigned byte takes on the base-10 values of 0 to 
255.  File sizes are often stated in bytes or multiples of bytes.  When measuring physical 
quantities, the following prefixes are defined by powers of 10: kilo- (103), mega- (106), giga- 
(109), tera- (1012), and peta- (1015).  When measuring file sizes, use powers of 2: 1 k = 210 = 1024 
bytes, 1 M = 220 ≈ 1.05e6 bytes, 1 G = 230 ≈ 1.07e9 bytes, 1 T = 240 ≈ 1.10e12 bytes, 1 P = 250 ≈ 
1.13e15 bytes. 
 
byte order – The order in which bits are read to construct a single byte or a multi-byte value 
(i.e., long integers and floats).  When reading binary data, it is important to know if the byte 
order of your machine differs from the byte order of the machine on which the file was created.  
If the byte order differs, you must swap the bits after reading them.  In the big-endian byte order, 
the most significant bit is listed first in the byte.  Most high-end computers today are big-endian.  
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In the little-endian byte order, the least significant bit is listed first.  Intel-compatible PCs and 
Digital VAX computers are little-endian.  The byte order is determined by the hardware, not the 
system software.  For example, a Linux system running on a PC will be little-endian, but Linux 
running on a SUN computer will be big-endian. 
 
CERES – Clouds and Earth's Radiant Energy System.  One of the TRMM instruments. 
 
color depth – Also referred to as the display depth.  To define the color of each pixel of an 
image, the pixel is assigned a number with a certain number of bits.  Eight-bit pixels were 
standard in the 1980s and most of the 1990s, but 24-bit pixels have recently become common. 
 
color table – The ordered set of colors used in an image with pixels generally no larger than 
eight bits.  Eight-bit color devices generally have a maximum of 256 colors in their color tables.  
Each color in a color table is usually defined by a red-green-blue (RGB) triplet. 
 
DAAC – Distributed Active Archive Center.  The Goddard Earth Sciences DAAC archives and 
distributes TRMM data to the public.  In recent years, the Goddard DAAC has been called the 
Data and Information Services Center (DISC).  [https://disc.sci.gsfc.nasa.gov/] 
 
dpi – Dots per inch. 
 
DPR – Dual-frequency Precipitation Radar.  The radar on the GPM satellite.  
 
EORC – Earth Observation Research Center.  An organization within JAXA.  
[https://www.eorc.jaxa.jp/en/index.html] 
 
ESRI – Environmental Systems Research Institute.  The company that makes the Arc line of GIS 
software.  [https://www.esri.com] 
 
fov – Field of view. 
 
FTP – File Transfer Protocol.  A popular way to transfer files between computers.  Anonymous 
FTP sites allow you to download files using "anonymous" as the username and your e-mail 
address as the password.  If you wish a file to be encrypted while being downloaded, use the 
UNIX program "scp" instead of FTP. 
 
GIF – Graphic Interchange Format.  The GIF image format uses loss-less compression and can 
be displayed by Web browsers. 
 
GIS – Geographical Information System.  A software package for generating and analyzing 
maps. 
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GMI – GPM Microwave Imager.  The passive microwave instrument on the GPM satellite. 
 
GPM – Global Precipitation Measurement. 
 
GSFC – Goddard Space Flight Center.  GSFC is NASA's research center located in Greenbelt, 
Maryland.  PPS and the Goddard DAAC are located at GSFC.  [https://www.gsfc.nasa.gov] 
 
GUI – Graphical user interface. 
 
HDF – Hierarchical Data Format.  A binary data format first developed by NCSA in the late 
1980s and adopted by NASA for its Earth-observing data in the early 1990s.  
[https://www.hdfgroup.org/] 
 
ICS – Interface Control Specification. 
 
IDL – Interactive Data Language.  This high-level language is developed by ExelisVIS, and it is 
the language in which the Orbit Viewer THOR is written.  IDL combines the ease of 
programming of a high-level language with some of the computation speed of low-level 
languages.  It also has built-in features useful to scientists such data format procedures (including 
HDF access routines), commands to define graphical user interfaces, and computation 
procedures. 
 
JAXA – Japan Aerospace Exploration Agency.  JAXA is the Japanese Government's counterpart 
to NASA.  Prior to October 2003, this organization was called the National Space Development 
Agency (NASDA).  [https://www.jaxa.jp] 
 
JPEG – Joint Photographic Expert Group.  The JPEG image format uses lossy compression and 
so is not well-suited for images that contain text or lines. 
 
LIS – Lightning Imaging Sensor.  One of the TRMM instruments.  Pronounced "l z." 
 
Mac OS X – Since 2001, the UNIX-based operating system of Macintosh computers.  The "X" 
is read as the letter "X," not the roman numeral 10.  The nicknames, versions, and release dates 
of this operating system are: Cheetah (v10.0, 2001), Puma (v10.1, 2001), Jaguar (v10.2, 2002), 
Panther (v10.3, 2003), Tiger (v10.4, 2005), and Leopard (v10.5, 2007).  [www.mac.com] 
 
mm/h – Millimeters per hour.  The unit of rainfall rate.  One inch per hour is 25.4 mm/h. 
 
NASA – National Aeronautics and Space Administration.  A Government agency of the United 
States of America.  [https://www.nasa.gov] 
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NCSA – National Center for Supercomputing Applications.  As the name would imply, NCSA 
develops applications for supercomputers and has also developed software such as telnet and the 
Mosaic Web browser and data formats such as HDF. 
 
NICT – The National Institute of Information and Communications Technology.  Prior to April 
2004, this organization was called the Communications Research Laboratory (CRL).  CRL built 
the TRMM Precipitation Radar.  [https://www.nict.go.jp] 
 
PMM – Precipitation Measurement Missions.  The NASA science team for both the TRMM and 
GPM satellites.  [https://pmm.gsfc.nasa.gov] 
 
PNG – Portable Network Graphic.  The PNG image format was developed in the 1990s, and 
most Web browsers can now display it.  PNG uses loss-less compression.  
[https://www.libpng.org] 
 
PPS – The Precipitation Processing System at NASA GSFC.  The organization that processes 
TRMM data to produce the TRMM standard products.  Prior to June 2008, this organization was 
called TSDIS.  [https://pps.gsfc.nasa.gov] 
 
PR – Precipitation Radar.  An instrument on the TRMM satellite. 
 
T H OR  – Tool for High-Resolution Observation Review.  The current version of the Orbit 
Viewer, which is a tool for displaying TRMM standard products produced at NASA's 
Precipitation Processing System at the Goddard Space Flight Center. 
 
TIFF – Tagged Image File Format.  An image format with loss-less compression. 
 
TMI – TRMM Microwave Imager.  An instrument on the TRMM satellite. 
 
TRMM – Tropical Rainfall Measuring Mission.  Pronounced "tr m."  
[https://trmm.gsfc.nasa.gov] and [https://www.eorc.JAXA.go.jp/TRMM] 
 
TSDIS – TRMM Science Data and Information System.  The former name for what is now 
called the Precipitation Processing System. 
 
VIRS – Visible and Infrared Scanner.  An instrument on the TRMM satellite. 
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